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PRINT SPECS

UNIT BLEED TRIM LIVE NON-BLEED AD

Page 8  3/4” x 11” 8  1/2” x 10 3/4” 7  3/4” x 10” 7  1/2” x 10”

222 x 279 mm 197 x 254 mm 191 x 254 mm 191 x 254 mm

Spread 17  1/4” x 11” 17” x 10 3/4” 15 1/2” x 10” 15” x 10”

438 x 279 mm 432 x 273 mm 394 x 254 mm 381 x 254 mm

2/3 Vertical 5 1/2” x 11” 5 3/8” x 10 3/4” 4 3/8” x 10” 4” x 10”

140 x 279 mm 137 x 273 mm 111 x 254 mm 101 x 254 mm

1/2 Island 5 1/2” x 8 1/4” 5 3/8” x 8 1/8” 4 3/4” x 7 1/2” 4 5/8” x 7 1/2”

140 x 210 mm 127 x 207 mm 120 x 197 mm 117 x 197 mm

1/2 Horizontal 8 3/4” x 5 3/4” 8 1/2” x 5 5/8” 7 1/2” x 5 1/8” 7” x 5”

222 x 146 mm 216 x 143 mm 197 x 130 mm 178 x 127 mm

1/2 Vertical 4 1/4” x 11” 4  1/8” x 10 3/4” 3  5/8” x 10” 3  5/8” X 9”

108 x 279 mm 105 x 273 mm 92 x 254 mm 92 x 229 mm

1/3 Vertical 3” x 11” 2 7/8” x 10 3/4” 2 1/2” x 10” 2” x 10”

72 x 279 mm 73 x 273 mm 64 x 254 mm 51 x 254 mm

1/3 Square 5 1/2” x 5 1/2” 5 3/8” x 5 3/8” 5” x 5” 4 5/8” x 4 7/8“

140 x 140 mm 137 x 137 mm 127 x 127 mm 117 x 124 mm

1/3 Horizontal 8 3/4” x 4 1/2” 8 1/2” x 4 1/4” 8” x 3 7/8” 7” x 3 3/8”

222 x 114 mm 216 x 108 mm 197 x 98 mm 178 x 86 mm

1/4 Traditional 4 5/8” x 5 3/4” 4 1/4” x 5 5/8” 3 3/4” x 4 1/2” 3 3/8” x 4 7/8”

117 x 146 mm 108 x 143 mm 95 x 114 mm 86 x 123 mm

1/4 Horizontal 8 3/4” x 3 3/8” 8 1/2” x 3 1/4” 8” x 2 7/8” 7” x 2 3/8”

222 x 86 mm 216 x 83 mm 197 x 73 mm 178 x 60 mm

*Always keep live matter a half-inch (12 mm) from trim.

AD SPECIFICATIONS FOR CARNETEC MAGAZINE (SPANISH AND PORTUGUESE EDITIONS)
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Printing Method: Web offset, saddle-stitched.

Color Proofs: One press-suitable proof (color lasers are NOT acceptable for press; they are permissible for  
ID purposes only).

Inserts: Contact the publisher about specifications for supplied inserts or for a quote on printing.

Send Print Advertising Materials to:
Production Manager 
CarneTec Magazine  
Specify Portuguese and/or Spanish Edition 
c/o Marketing & Technology Group 
1415 N Dayton St, Chicago, IL 60642 USA

Phone: +1 312-274-2204   Fax: +1 312-266-3385

Email: Spanish edition materials to: printmaterialsct@carnetec.com and Portuguese edition materials to 
printmaterialsbip@carnetec.com or Upload: http://sendit.mtgmediagroup.com

Digital Specification Highlights:

•  The magazine is a 8 1/2” x 10 3/4” trim (216 x 273 mm), saddle-stiched publication.

•  Ad corrections to be made by publisher will be rebilled at a rate of $150/hour and require original native files 
from the client.

•  We require press-optimized PDFs (PDF-X1a), but we also accept native Mac files:  
InDesign, Illustrator or Photoshop in CS3, CS4 or CS5 format.

•  All artwork must be a minimum of 266-300 dpi.

•  All art should be saved as CMYK or Grayscale (not RGB).

•  All fonts must be embedded. If supplying native Mac files, please package all images and fonts.

AD SPECIFICATIONS FOR CARNETEC MAGAZINE CONTINUED

http://sendit.mtgmediagroup.com
mailto:printmaterialsct%40carnetec.com?subject=
mailto:printmaterialsbip%40carnetec.com?subject=
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Your banner ad rotates randomly throughout CarneTec. 

 

Display size: 728 (w) x 90 (h) pixels, 72 dpi gif or jpeg file

File size: 250k ideal, 400k max

Appears: At top of page, Run of Site

Materials needed:

1.  Gif or Jpeg (flash not recommended for view on iPad or iPhone)

2.  URL (to generate click-throughs and drive traffic to your website)

3.  VIDEO (to generate video plays and drive traffic to your website). Video specifications and upload instructions.

4.  Email GIF or jpeg and URL to: webmaterialscol@carnetec.com (Spanish language materials);  
webmaterialsbol@carnetec.com (Portuguese language materials)

Other: Flash is not recommended because iOS devices don’t support it but if flash specifications are needed, click here.

Your logo and 30-word message are featured on the home page of CarneTec.  
Static ads only – No animation

Logo: 80 (w) x 60 (h) pixels, 300 dpi gif or jpeg

File size: 250k ideal, 400k max

Headline: 8 words maximum

Copy: 30 words maximum

Appears: On CarneTec home page

Materials needed:

1.  Gif or Jpeg logo

2.  8 word headline and 30 words of copy maximum

3.  URL (to generate click-throughs and drive traffic to your website)

4.  VIDEO (to generate video plays and drive traffic to your website). Video specifications and upload instructions.

5.  Email GIF or jpeg logo, copy and URL to: webmaterialscol@carnetec.com (Spanish language materials); 
webmaterialsbol@carnetec.com (Portuguese language materials)

SEND WEB AD MATERIALS TO:

Production Manager 
CarneTec Magazine
c/o Marketing & Technology Group 
webmaterialscol@carnetec.com (Spanish language materials); 
webmaterialsbol@carnetec.com (Portuguese language materials) 
Phone: +1 312-274-2204    Fax: +1 312.266.3385

MATERIALS DUE  
Unless otherwise indicated, all materials for web ads are due TWO (2) WEEKS prior to post date.

CarneTec Lead System and Video Ad Option for Web Ads
Nearly all CarneTec web ads can be enhanced with video. Potential customers can interact with ads in three 
ways: 1) Request a contact (sales lead); 2) click-through to visit your website; and 3) play a video.

ONLINE SPECS: WEB ADS FOR WWW.CARNETEC.COM

BANNER AD

FRONT PAGE ICON AD

mailto:webmaterialscol%40carnetec.com?subject=
mailto:webmaterialsbol%40carnetec.com?subject=
mailto:webmaterialscol%40carnetec.com?subject=
mailto:webmaterialsbol%40carnetec.com?subject=
mailto:webmaterialscol%40carnetec.com?subject=
mailto:webmaterialsbol%40carnetec.com?subject=
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Tower ads appear prominently throughout CarneTec in the top of the right-hand 
column of the site. Tower ads appear most frequently on the highly-trafficked Daily 
News page. They also appear on Technical Articles, Supplier Showroom, Supplier 
Directory and many other sections. 

Static ads only – No animation

Display size: 240 (w) x 400 (h) pixels, 72 dpi gif or jpeg

File size: 250k ideal, 400k max

Appears: Run of Site, most frequently on Daily News

Materials needed:

1. Gif or Jpeg

2.  URL (to generate click-throughs and drive traffic to your website)

3.  VIDEO (to generate video plays and drive traffic to your website).  
Video specifications and upload instructions.

4.  Email GIF or jpeg and URL to: webmaterialscol@carnetec.com (Spanish 
language materials); webmaterialsbol@carnetec.com  
(Portuguese language materials)

TOWER AD

Your NewsSpot ad appears adjacent to CarneTec.com’s Daily News stories.  
Ads are impression-based, meaning that you pay only for actual views from  
a buying influence member. Place your ad in the news categories that are a  
good fit for your brand: 

Animation: allowed only for the first three seconds of the ad and may not repeat

Display size: 250 (w) x 270 (h) pixels, 72 dpi gif or jpeg

File size: 250k ideal, 400k max

Appears: On Daily News page

Materials needed:

1. Gif or Jpeg

2.  URL (to generate click-throughs and drive traffic to your website)

3.  VIDEO (to generate video plays and drive traffic to your website).  
Video specifications and upload instructions.

4.  Email GIF or jpeg and URL to: webmaterialscol@carnetec.com (Spanish language materials);  
webmaterialsbol@carnetec.com (Portuguese language materials)

NEWSSPOT AD

• Beef News

• Export Markets

• Financial News

• Food Safety

• Foodservice News

• General News

• Pork News

• Poultry News

• Retail News

• Special Events

mailto:webmaterialscol%40carnetec.com?subject=
mailto:webmaterialsbol%40carnetec.com?subject=
mailto:webmaterialscol%40carnetec.com?subject=
mailto:webmaterialsbol%40carnetec.com?subject=
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Your ad appears adjacent to one of CarneTec (Spanish only) Blogs. Ads are 
impression-based, meaning that you pay only when a buying influence member 
views your ad. Your ad can appear in any of the following blogs: 

•  Animal Welfare and Health – Belisario Roberto Eyzaguirre-Rojas,founder of 
the Peruvian National Service of Agricultural Safety, (Lima Peru) focuses on 
issues relating to animal health, well-being, handling and animal slaughter.

•  Development and Challenges of New Beef Cuts – Dr. Antonio (Tony) Mata, 
creator of the Las Vegas Strip Steak, shares his perspectives on the U.S. and 
Latin American beef industry. The value, use and challenges of beef carcasses 
will be covered along with new and traditional beef cuts.  

•  Experiences in Food Safety – Eugenia Jimenez, M. C. , project manager for 
IDEA Consultants, shares her experience and views on topics and issues 
concerning food safety.

•  Innovations in Meat Processing Equipment – Dr. Luis Moreno, director and 
founder, Gerencia de Procesos Alimenticios-GPA. (Maracaibo, Venezuela) Luis 
Moreno discusses developments and innovations in meat processing 
equipment.

•  Insight into the Pork Industry – Erika Voogd, president of Voogd Consulting 
based in West Chicago, IL, discusses the ins-and-outs of the pork industry and 
experiences in Latin America in her monthly column. Pork health and 
handling, slaughter practices, along with safety and quality of pork meat 
products will be covered. 

•  Poultry Science: Opinion and Analysis – Dr. Christine Alvarado, associate 
professor in poultry science, Texas A&M University (USA) shares her insights 
on important topics to poultry processors, such as bird slaughter, first and 
further processing, food safety and quality, product packaging.

•  Meat Technology – Dr. Jesus Velazco, editor at large and the founding editor 
of CarneTec magazine, shares his knowledge, experience and analysis on 
various aspects of the meat processing.

Animation: Only allowed for the first 3 seconds of the ad and may not repeat

Display size: 250 (w) x 270 (h) pixels, 72 dpi gif or jpeg

File size: 250k ideal, 400k max

Appears: Within CarneTec Blogs; Advertiser Specifies Blog

Materials needed:

1. Gif or Jpeg

2.  URL (to generate click-throughs and drive traffic to your website)

3.  VIDEO (to generate video plays and drive traffic to your website).  
Video specifications and upload instructions.

4. Email GIF or jpeg and URL to: webmaterialscol@carnetec.com

BLOGSPOT AD (SPANISH ONLY)

mailto:webmaterialscol%40carnetec.com?subject=
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Sample ad

Target buyers with precision using contextual advertising. TechSpot (Spanish only) ads appear adjacent to highly 
relevant editorial content in the Technical Articles, Supplier Showroom and Supplier Directory sections of CarneTec. 
Ads are impression-based, meaning that you pay only when a buying influence member views your ad. Select a 
topic area related to your brand from the list below. 

Headline: 5 words maximum

Copy: 25 words maximum

Materials needed:

1.  5 word headline and 25 words or less of copy

2.  URL (to generate click-throughs and drive traffic to your website)

3.  VIDEO (to generate video plays and drive traffic to your website). Video specifications and upload instructions.

4.  Email Spanish copy and URL to: webmaterialscol@carnetec.com

TECHSPOT AD

• Casings

• Common Plant Equip.

• Cooking, Smoking, Frying

• Cooling, Freezing

• Further Processing

• Ingredients, Seasonings

• Packaging Accessories

• Packaging Machines

• Packaging Materials

• Poultry Killing/Cutting/Deboning

• Red Meat Killing/Cutting/Boning

• Rendering

• Safety

• Sanitation/Pollution Control

• Special Services

• Transportation

Logo Stopper ads appear within each product listing in the online  
Supplier Directory (Spanish only), enhancing your brand and providing  
a high-quality link from CarneTec to your website.

Logo: 145 (w) x 34 (h) pixels, 300 dpi gif or jpeg

File size: 250k ideal, 400k max

Materials needed:

1.  Gif or Jpeg logo

2.  URL (to generate click-throughs and drive traffic to your website)

3.  VIDEO (to generate video plays and drive traffic to your website). Video specifications and upload instructions.

4.  Email GIF or jpeg logo and URL to: webmaterialscol@carnetec.com

LOGO STOPPER AD

mailto:webmaterialscol%40carnetec.com?subject=
mailto:webmaterialscol%40carnetec.com?subject=
http://www.marketingandtechnology.com/repository/demo/carnetec/demo/tech.html
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MATERIALS DUE  
One month prior to magazine issue date

Article sponsorships connect your brand with quality technical content in the  
CarneTips/CarneDicas e-newsletters and on CarneTec.com. Your company’s four-color  
logo and 50-words of copy appear below the article on CarneTec.com. 

Logo: 150 (w) x 150 (h) pixels, 300 dpi gif or jpeg

File size: 250k ideal, 400k max

Copy: 50 words maximum

Appears: Within the CarneTips/CarneDicas newsletter and on Carnetec.com in the Technical Articles section

Materials needed:

1. Gif or Jpeg logo

2. 50 words of copy or less

3.  URL (to generate click-throughs and drive traffic to your website)

4.  VIDEO (to generate video plays and drive traffic to your website). Video specifications and upload instructions.

5.  Email GIF or jpeg logo, copy and URL to: webmaterialscol@carnetec.com (Spanish language materials); 
webmaterialsbol@carnetec.com (Portuguese language materials)

ARTICLE SPONSORSHIP

A Showroom Sponsorship provides new product coverage in the CarneTips/CarneDicas e-newsletters and in the Supplier 
Showroom (Vitrina) on CarneTec.com. Generate sales leads, click-throughs to your website and views of your latest video. 

Product release: Word document

Photo: 300 dpi gif or jpeg, at least 3” x 5”

Materials needed:

1. Gif or Jpeg product photo

2. Product release word document

3. URL (to generate click-throughs and drive traffic to your website)

4.  VIDEO (to generate video plays and drive traffic to your website). Video specifications and upload instructions.

5.  Email GIF or jpeg product photo, product release and URL to: webmaterialscol@carnetec.com  
(Spanish language materials); webmaterialsbol@carnetec.com (Portuguese language materials)

SHOWROOM SUPER SPONSORSHIP

MATERIALS DUE  
One month prior to magazine issue date

mailto:webmaterialscol%40carnetec.com?subject=
mailto:webmaterialsbol%40carnetec.com?subject=
mailto:webmaterialscol%40carnetec.com?subject=
mailto:webmaterialsbol%40carnetec.com?subject=
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Sample

CarneTec positions your whitepaper or other quality content where buyers will find it. Sponsored 
Content packages include:

•  A synopsis of your white paper in the Sponsored Content area of the technical article index 
section for two weeks – with a link back to your website

•  Front page icon ad for two weeks

•  Article sponsorship – it will link to full white paper

•  Second position in CarneTips/CarneDicas e-newsletters – it will link to full white paper.

•  Executive summary in the print issue

•  Positioning in technical article search engine

Materials needed:

1. Whitepaper

2. 8 word headline and 30 words of copy for front page icon ad (click here for specs)

3. 50 words of copy for article sponsorship (click here for specs)

4. Gif or Jpeg logo

5.  URL (to generate click-throughs and drive traffic to your website) for icon ad and  
article sponsorship

6.  VIDEO (to generate video plays and drive traffic to your website).  
Video specifications and upload instructions.

7.  Email all items to: webmaterialscol@carnetec.com (Spanish language materials); 
webmaterialsbol@carnetec.com (Portuguese language materials)

SPONSORED CONTENT

MATERIALS DUE  
Two weeks prior to posting date

mailto:webmaterialscol%40carnetec.com?subject=
mailto:webmaterialsbol%40carnetec.com?subject=
http://www.marketingandtechnology.com/repository/demo/carnetec/demo/tech.html
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SEND NEWSLETTER AD MATERIALS TO:

Production Manager  
CarneTec Magazine 
c/o Marketing & Technology Group 
webmaterialscol@carnetec.com (Spanish language materials); 
webmaterialsbol@carnetec.com (Portuguese language materials)     
Phone: +1 312-274-2204    Fax: +1 312-266-3385

MATERIALS DUE  
Unless otherwise indicated, all materials are due TWO (2) WEEKS prior to e-newsletter date

NEWSLETTERS

Every weekday meat and poultry processors throughout Brazil receive their 
news update from CarneTec (Portuguese). Throughout Spanish speaking 
Latin America the news is delivered twice a week on Monday and Thursday 
mornings. Your company is featured prominently at the top of the 
e-newsletter with your logo and sponsorship copy. Sponsors can choose to 
run different copy each day if desired. Sponsorship generates leads and 
click-throughs. Requests to be contacted are forwarded to advertisers in real 
time as a sales lead.

Logo: 145 (w) x 34 (h) pixels, 72 dpi gif or jpeg 

File size: 250k ideal, 400k max

Copy: 50 words maximum

Materials needed:

1.  Gif or Jpeg logo

2.  50 words of copy or less

3.  URL (to generate click-throughs and drive traffic to your website)

4.  Email GIF or jpeg logo, copy and URL to:  
webmaterialscol@carnetec.com (Spanish language materials) 
webmaterialsbol@carnetec.com (Portuguese language materials)

NOTICIAS DE LA INDUSTRIA (SPANISH)/NOTÍCIAS DA INDÚSTRIA (PORTUGUESE)

mailto:webmaterialscol%40carnetec.com?subject=
mailto:webmaterialsbol%40carnetec.com?subject=
mailto:webmaterialscol%40carnetec.com?subject=
mailto:webmaterialsbol%40carnetec.com?subject=
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CarneTips (Spanish)/CarneDicas (Portuguese) is a weekly e-newsletter 
featuring new technical articles, new products and supplier news. Your 
company sponsors a technical article (articles are listed in the online 
editorial calendar) that appears in the e-newsletter. In addition to your 
logo and sponsorship copy appearing prominently at the top of the 
e-newsletter, an ad is placed adjacent to the technical article online. 
Readers can click on your website copy to view a video (optional), visit 
your website or request more information, which results in a sales lead for 
your company. 

Logo: 145 (w) x 34 (h) pixels, 72 dpi gif or jpeg 

File size: 250k ideal, 400k max

Copy: 50 words maximum

Materials needed:

1.  Gif or Jpeg logo

2.  50 words of copy or less

3.  URL (to generate click-throughs and drive traffic to your website)

4.  Email GIF or jpeg logo, copy and URL to:  
webmaterialscol@carnetec.com (Spanish language materials);  
webmaterialsbol@carnetec.com (Portuguese language materials)

CARNETIPS/CARNEDICAS E-NEWS SPONSORSHIP

mailto:webmaterialscol%40carnetec.com?subject=
mailto:webmaterialsbol%40carnetec.com?subject=
http://mk1.marketingandtechnology.com/acc1.php
http://mk1.marketingandtechnology.com/acc2.php
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The CarneTec Blogs e-newsletter (in Spanish) provides insightful 
commentary from industry thought leaders on a variety of topics:

•  Animal Welfare and Health Blog – Belisario Roberto Eyzaguirre-Rojas 
focuses on issues relating to animal health, well-being, handling and 
animal slaughter. He is founder of the Peruvian National Service of 
Agricultural Safety (SENASA). 

•  Experiences in Food Safety by Eugenia Jimenez, MC – Industry 
consultant, Eugenia Jimenez, offers opinions on issues and concerns in 
food safety.

•  Development and Challenges of New Beef Cuts – Dr. Antonio (Tony) 
Mata, creator of the Las Vegas Strip Steak, shares his perspectives on 
the U.S. and Latin American beef industry. The value, use and 
challenges of beef carcasses will be covered along with new and 
traditional beef cuts.

•  Innovations in Meat Processing Equipment – Luis Moreno, director 
and founder, Gerencia de Procesos Alimenticios-GPA in Maracaibo, 
Venezuela, discusses developments and innovations in meat 
processing equipment. 

•  Insight into the Pork Industry – Erika Voogd, president of Voogd Consulting based in West Chicago, IL, discusses 
the ins-and-outs of the pork industry and experiences in Latin America in her monthly column. Pork health and 
handling, slaughter practices, along with safety and quality of pork meat products will be covered. 

•  Meat Technology by Dr. Jesus Velazco – Editor at Large of CarneTec, Jesus Valazco shares his knowledge, 
experience and analysis of meat processing. 

•  Poultry Science: Opinion & Analysis – Christine Alvarado, associate professor in poultry science, Texas A&M 
University (USA), shares insights on important topics to poultry processors, such as bird slaughter, first and 
further processing, food safety and quality as well as product packaging. 

Your logo and 50-word sponsor message reach nearly 3,000 Latin American subscribers (excluding Brazil). Generate 
sales leads and click-throughs.

Logo: 145 (w) x 34 (h) pixels, 72 dpi gif or jpeg

File size: 250k ideal, 400k max

Copy: 50 words maximum

Materials needed:

1.  Gif or Jpeg logo

2.  50 words of copy or less

3.  URL (to generate click-throughs and drive traffic to your website)

4.  Email GIF or jpeg logo, copy and  
URL to: webmaterialscol@carnetec.com (Spanish language materials)

CARNETEC BLOGS E-NEWS SPONSORSHIP (SPANISH ONLY)

mailto:webmaterialscol%40carnetec.com?subject=
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VIDEO ENHANCED

Nearly all CarneTec web ads can be enhanced with video, providing another way for a prospect to 
engage with your brand. 

Video Size: 500 MB

Duration: 3 minutes maximum (1-2 minutes recommended)

File Types:  3g2, 3gp, asf (streaming for Windows Media Player), avi, dv, flv (VP6), mov (QuickTime 
multimedia), mp4 (H.264), mpeg, mpg (MPEG-1 and MPEG-2), qt (QuickTime), wmv (Windows Media 
Video). FLV (VP6) files cannot be played on iOS and some Android devices.

Aspect ratios: 16:9 or 4:3

VIDEO UPLOAD INSTRUCTIONS

Step 1: Go to Site address: http://sendit.mtgmediagroup.com

Step 2: Fill out all required fields on page 1 of two-page upload form:

Step 3: Click NEXT to go to page 2 of two-page upload form

Step 4: Under SELECT A FILE prompt

• Browse system for appropriate video file to upload (You can add multiple files)

Step 5: Click SEND IT

• Video is uploaded to CarneTec production department

Questions?  
Contact CarneTec Production Department at +1 312-274-2204

VIDEO ENHANCED AD SPECIFICATIONS

• Publication

• Advertiser Name

• Contact Name

• Phone Number

• Email Address

• Subject Line

•  Description — identifying name for video & any special notes-
you cannot go to next page without filling in every field

http://sendit.mtgmediagroup.com
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3RD-PARTY TRAFFICKED ADS/FLASH

We accept third party trafficked ads on the website, but not in e-newsletters. Only 
ads from DoubleClick and Media Plex are fully integrated into our lead reporting 
system. Contact your account executive to make sure your third party trafficked 
ad provider is fully integrated with our system to receive maximum value for your 
web advertising. Please allow approximately 30 days for complete integration of 
3rd party trafficked ads.

Because Flash is not supported on iOS mobile devices, your ad may not be 
viewable if designed in Flash.

Requirements for Flash ads

• Dimensions: 728 (w) x 90 (h) pixels

• Flash versions: All ads must be published to Flash Player version 4-9.

• ActionScript version: 2 only.

•  Include an alternate image: A static .gif or .jpg version of the banner should 
be included (it must have the same dimensions as the Flash ad).

•  Cover stage: The stage of the movie (the visible area) should be covered 
completely by an opaque shape or symbol. See instructions below for more 
information.

•  Clicktag: Ads must make use of a clicktag. Please use all lowercase when 
naming this parameter (i.e. ‘clicktag’). Instructions for adding a clicktag and 
the invisible button required are included below.

•  Remotely hosted content: Remotely hosted content such as .swf, .flv,  
or image files is not allowed.

3RD PARTY TRAFFICKED ADS

FLASH ADS

http://mk1.marketingandtechnology.com/MP2016/contact.php
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INSTRUCTIONS FOR CREATING A FLASH AD

When creating a Flash banner for CarneTec, following these steps will ensure that the ad displays and functions 
correctly.

NOTE: Please use ActionScript 2.0 and target Flash Player 9 or earlier (see Step C). This prevents problems when 
viewers have an older version of the Flash Player installed. Loading remotely hosted content (.swf, .flv, or image files) 
is not allowed.

A. Create an invisible button

NOTE: If you know how to create an invisible button, skip to Step B.

1. Add a layer named “button” to your Flash movie and drag it to the top of the list of layers.

2.  With the “button” layer selected, use the rectangle tool to create a rectangle the size of the stage  
(the viewable area in Flash).

3.  Double-click the rectangle and hit the F8 key (or select Modify > Convert to Symbol).

4. Give your button a name and make sure that “Button” is selected. Click OK.

5. Double-click the button you just created to open it.

6.  In the timeline, click the frame labeled “Hit” to select it, then hit the F6 key  
(or select Insert > Timeline > Keyframe).

7. Now click the frame labeled “Up” to select it, then hit the Delete key to delete its contents.

8. The invisible button has been created. Click the Scene 1 button below the timeline to return to the main timeline.

B. Add the ActionScript

1. Select the button and open the Actions window (select Window > Actions).

2. If a button action already exists, please delete it.

3.  Making sure that the button is still selected, copy and paste the following ActionScript into the Actions window  
(NOTE: it must appear exactly as shown):

on (release) {

    if (clicktag.substr(0,5) == “http:”) {

        getURL(clicktag);

    }

}

C. Cover the stage completely

Be sure that the entire stage (the visible part of the movie) is covered by shapes or symbols. This prevents the 
background color of the HTML page from showing through in the banner. Placing a rectangle in the bottom layer that 
covers the stage and is filled with a solid color or gradient (no alpha transparency) is the easiest way to achieve this.

D. Publishing settings

On the Flash tab in Publish Settings (File > Publish Settings), Flash Player 9 or earlier should be selected under 
Version. The ActionScript version should be 2.0. If you were planning to use ActionScript 3.0 or target Flash Player 9+, 
please see the note at the top of these instructions.

E. Send the Flash files

Please send the Flash banner to webmaterialscol@carnetec.com and/or webmaterialsbol@carnetec.com in both .fla 
and .swf formats, and include the destination URL for the banner.

FLASH ADS CONTINUED
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